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1. Introduction 

This document is intended to function as a Nevada Department of Transportation (NDOT) internal Self help 
guide for developing a simple hydrologic model using HEC-HMS. The model was developed based on the 
functions available in HEC-HMS Version 4.6. The example does not explain all the functions within HEC-HMS 
but makes use of the common functions available within the model software. The example was developed 
using an example watershed model (Section 2) supplied by NDOT. Within the example, notes are added 
where the modeling methods deviate from the Original Hydrologic Study and where NDOT specific methods 
were utilized. 

2. Original Hydrologic Study 

The reference Bailey Canyon Hydrologic Study was completed for the Washoe County Regional Transit 
Commission (RTC) in 2011. The project location and vicinity are shown in Figure 1. The hydrologic analysis 
consisted of a HEC-1 model with 11 subbasins, 6 routing reaches, 1 flow diversion, and 9 concentration points 
(Junctions). Rainfall losses were originally calculated using the Natural Resources Conservation Service 
(NRCS) curve number methodology and utilized soil, vegetation, and land use data. Flows were developed 
using the unit-hydrograph methodology. The precipitation depth was specified using NOAA Atlas 14 data 
with a fixed areal reduction of 0.98 of the point rainfall applied to all subbasins. The precipitation hyetograph 
was specified in the HEC-1 model using a JR record for a balanced storm distribution. 
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Figure 1  Project Location and Vicinity 
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3. Example Model using Green and Ampt Methods 

The original hydrologic study was updated using the Green and Ampt methods/data processed as part of the 
overall project. Calculation of Green and Ampt parameters was accomplished using Nevada Department of 
Transportation (NDOT) Geographic Information System (GIS) data derived from NRCS soils surveys. The 
project watersheds fall within soil survey areas for Nevada (NV) NV628 And NV772 and data was calculated 
for the most restrictive layer within the top three inches of the soil column. 

Green and Ampt parameters for use in HEC-HMS are defined as follows: 

Initial Content Dry - Volumetric soil moisture content expressed as Wilting Point (WPOINT) at 
start of rainfall, in inches, 

 Normal - Volumetric soil moisture content expressed as Field Capacity 
(FCAPAC) at start of rainfall, in inches, 

Saturation (SAT) Volumetric soil moisture content at saturation, in inches, 

Suction (PSIF)   Wetting front capillary suction, in inches,  

Conductivity (XKSAT) Bare ground effective hydraulic conductivity at natural saturation, in 
inches/hour, and 

Impervious % Effective impervious area including soils and land use imperviousness, in 
percent. 

Polygons of the subbasins were intersected with NDOT soils data to determine Green and Ampt parameter 
subareas within each subbasin. For subbasins with multiple soil map units present, Saturation (SAT), and 
Initial Content (Wpoint/FCapac) values were calculated via simple area weighted average of the soil map 
units in each of the subbasins. Suction (PSIF) and Conductivity (XKSAT) were calculated based upon a 
logarithmic area weighted average of the soil map units in each of the subbasins. Polygon intersection can 
be conducted using standard ArcMap routines. The Excel file provided in the example data includes all the 
soils/subbasins intersected values. 

3.1 Processing NDOT polygon shapefiles using ArcMap and Excel 

The following shape files have been provided for this example: 

• soilmu_a_nv628 – Green and Ampt shapefile for Nevada Soils Survey 628 

• soilmu_a_nv772 – Green and Ampt shapefile for Nevada Soils Survey 628 

• Bailey_Landuse – Land use data digitized from the original Bailey Canyon Study 

• Bailey_Basins – Subbasins for Bailey Canyon Watershed 

• Bailey_Junctions – Hydrologic modeling junctions for Bailey Canyon Watershed 

• Bailey_Routes – Hydrologic routing reaches for Bailey Canyon Watershed 

3.1.1 Merging Green and Ampt soils shapefiles 

To develop basin specific Green and Ampt parameters, merging of the shapefiles soilmu_a_nv628 and 
soilmu_a_nv772 is recommended to facilitate further processing, this allows subsequent functions and 
calculations to be performed on a single soils dataset rather than multiple (two in this case). This can be 
accomplished using the “Merge” geoprocessing tool in ArcMap. 

 



  

P 6 7 4 - 1 9 - 8 0 3  P a g e  4 

In the ArcMap menu bar, navigate to “Geoprocessing” → “Merge”. Within the merge dialogue box, under 
“Input Datasets” add both Green and Ampt soils shapefiles. Provide an output shapefile/feature class name 
and file location then select “OK”.  If successful, after a few seconds the “Merged” Green and Ampt soils 
shapefile will be added to the map layers. 

 

 

3.1.2 Intersecting Green and Ampt soils and Land Use shapefiles to develop subbasin specific 
parameters. 

When developing subbasin specific Green and Ampt parameters the “Merged” Green and Ampt soils 
shapefile needs to be intersected with the subbasin shapefile then intersected with the land use shapefile. 
While Green and Ampt infiltration parameters are primarily based upon soils data, land use data is used to 
estimate antecedent moisture conditions, surface storage, and land use based imperviousness; an 
intersection step with the land use shapefile will be used to develop the effective impervious area and initial 
soil moisture content for each subbasin (See Section 3.2). 
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In the ArcMap menu bar, navigate to 
“Geoprocessing” → “Intersect”. Under “Input 
Datasets” add the Merged Soil shapefiles created 
in Section 3.1.1 and subbasin boundaries 
(Bailey_Basins.shp). Provide an output shapefile 
name and location then select “OK”. If successful, 
after a few seconds the intersected shapefile will 
be added to the map layers. 

Run the process again by adding the newly created 
shape file (Bailey_Soils_Basins_Intersect.shp) and 
Bailey_Landuse. Again, provide an output shapefile 
name and location then select “OK”. If successful, 
after a few seconds the intersected shapefile will 
be added to the map layers. 
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As a final step before exporting the data and processing in the Excel spreadsheet, update the “ Area_AC” 
column. This can be accomplished by highlighting the layer “Bailey_Basins_Soils_Landuse_Intersect”, right 
mouse click to “open attribute table”. Next highlight “Shape_Area” column then select “Calculate Geometry”  
For this example select “Area“ under top pull down menu, use coordinate system of the data frame and 
select “Acres US [ac]” under lower pull down menu. 

 

 

The next step in the process will extract the data from the shapefile 
Bailey_Basins_Soils_Landuse_Intersect.shp and add it to the 
spreadsheet prepared for this example. The spreadsheet, 
Bailey_3in_Green&Ampt.xlsx, located in folder 07_DataFiles, was 
created as one example of how to process Green and Ampt data for 
hydrologic modeling.  Note: The modeler should use a process (GIS, 
Python, Excel etc. ) they are most comfortable with as long as the results 
match the values in Table 5. 
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With the attribute table still open, select “Table Options” in the upper left 
corner and select “Select All” from the pull-down menu. Next, position the 
cursor anywhere along the left side of the table and right mouse click and a 
menu will pop up and select “Copy Selected”.  Now the data is ready to 
“Paste” into the spreadsheet.  Open the Excel spreadsheet, navigate to tab 
“Bailey_G&A_Data”, position cursor in cell A1 and paste shapefile data into 
spreadsheet.  After the data is added to the spreadsheet, Sort the data in 
ascending order by the “name” column (Subbasin ID).  If the data is pasted 
correctly, Table 5 on tab “Report Tables” should match Table 5 below. 

3.2 Determining hydrologic parameters for HEC-HMS loss modeling 

All the data necessary to calculate Green and Ampt Loss parameters for 
input to HEC-HMS are now included in the shapefile data. For this example, 
the shapefile data that was added to the Excel spreadsheet for, 

1. Determining Percent of Effective Impervious area for each Subbasin (Section 3.2.1) 

2. Determining Controlling Initial Soils Moisture Content for each Subbasin (Section 3.2.2) 

3. Determining Initial Content, Saturated Content, Suction and Conductivity for each Subbasin (Section 
3.2.3) 

For this example, subbasin 035, represented by 17 soils/land use subareas was extracted directly out of the 
relevant columns in Bailey_Basins_Soils_Landuse_Intersect.shp prepared in Section 3.1 (Table 1). 

. 

Table 1  Subbasin 035 Data 
Subbasin Soil 

Survey ID 

Soil Map 

Unit 

WPOINT 

[IN] 

FCAPAC 

[IN] 

SAT 

[IN] 

PSIF 

[IN] 

XKSAT 

[IN/HR] 

Effective 

Impervious 

[%] 

Subbasin 

Area 

[AC] 

35 NV628 482 0.066 0.132 0.441 0.0720 1.0806 0.0000 4.40 

35 NV628 482 0.066 0.132 0.441 0.0720 1.0806 0.0000 0.07 

35 NV628 482 0.066 0.132 0.441 0.0720 1.0806 0.0000 1.12 

35 NV628 482 0.066 0.132 0.441 0.0720 1.0806 0.0000 9.65 

35 NV628 482 0.066 0.132 0.441 0.0720 1.0806 0.0000 1.50 

35 NV628 1520 0.117 0.235 0.437 7.6430 0.2584 0.0000 1.78 

35 NV628 1520 0.117 0.235 0.437 7.6430 0.2584 0.0000 0.27 

35 NV628 1520 0.117 0.235 0.437 7.6430 0.2584 0.0000 31.63 

35 NV628 1520 0.117 0.235 0.437 7.6430 0.2584 0.0000 105.51 

35 NV628 1520 0.117 0.235 0.437 7.6430 0.2584 0.0000 137.82 

35 NV628 1520 0.117 0.235 0.437 7.6430 0.2584 0.0000 8.73 

35 NV628 251 0.093 0.182 0.431 3.1800 0.5021 0.0000 0.40 

35 NV628 251 0.093 0.182 0.431 3.1800 0.5021 0.0000 9.80 

35 NV628 251 0.093 0.182 0.431 3.1800 0.5021 0.0000 3.77 

35 NV628 251 0.093 0.182 0.431 3.1800 0.5021 0.0000 0.77 

35 NV628 251 0.093 0.182 0.431 3.1800 0.5021 0.0000 0.09 

35 NV628 251 0.093 0.182 0.431 3.1800 0.5021 0.0000 13.73 
Note:  Abbreviations used in column headings match shapefile
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3.2.1 Determining Percent Effective Impervious Area for each Subbasin 

In applying Green and Ampt methodology, the “Percent Impervious Area” attribute may be calculated 
through a composite of soils imperviousness and land use imperviousness. 

Soils imperviousness is included in the NDOT soils data shapefiles as PERC_ROCK or Percent Rock. This 
terminology is consistent with the original NRCS soils data. For the purposes of consistency with Green and 
Ampt reference documentation, Soils (Natural) Imperviousness is used in this document. 

Land use imperviousness was determined using the land use composition within each subbasin. Land use 
composition for each area were then cross-referenced with Table 2 to determine the approximate percent 
imperviousness for each land use category.  

For this example, Initial Moisture content and % Imperviousness were set using the original hydrologic study 
land use categories and reference tables found in the ADOT Hydrology Manual (Arizona Department of 
Transportation, 2014) and Mohave County (Arizona) Drainage Design Manual (latest edition). 

Table 2  Assigned Land Use with Initial Moisture and % Impervious Assumptions 

Land Use Code 

 
Land Use Name 

Initial Moisture 

Condition 

Land use Imperviousness 

[% 0-100] 

OS Open Space dry 0 

GR General Rural dry 12 

LDS Low Density Suburban dry 14 

MDS Medium Density Suburban normal 22 

MDR Medium Density Rural normal 6 

PR Parks and Recreation dry 0 

PSP Public and Semi-Public Facilities dry 0 

GC General Commercial dry 85 

HDS High Density Suburban normal 54 

Note: For this example, values in Table 2 are not included in the Bailey_Landuse.shp file however the modeler 
may choose to add these values to simplify processing of Initial Soils Moisture Content and Percent of 
Effective Impervious area for each Subbasin. 

Once values for percent impervious areas are determined for both soil and land use attributes, the two values 
are then composited using simple area weighted average for use within HEC-HMS. Calculated values for soils 
and land use imperviousness are shown in Table 3 and can be found in Bailey_3in_Green&Ampt.xlsx on All 
Subbasins tab, columns “Soils % Imp” and “Land use % Imp” with effective imperviousness found on column 
“Effective % Impervious”. Effective Impervious percentage per subbasin assumes impervious area is 
hydraulically directly connected to the basin outlet.  
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Table 3  Subbasin Effective Imperviousness  

Subbasin 

Weighted Soils 

(Natural) 

Imperviousness 

[% 0-100] 

Weighted Land use 

Imperviousness 

[% 0-100] 

1Weighted Effective 

Imperviousness 

[% 0-100] 

005 0.0% 0.0% 0.0% 

010 0.0% 0.0% 0.0% 

015 0.0% 0.0% 0.0% 

020 0.0% 0.0% 0.0% 

025 0.0% 1.4% 1.4% 

030 0.0% 4.3% 4.3% 

035 0.0% 6.0% 6.0% 

040 0.0% 12.1% 12.1% 

045 0.0% 10.7% 10.7% 

050 0.0% 22.6% 22.6% 

055 2.9% 21.4% 24.3% 
Note 1: Weighted Effective Imperviousness is the sum of Weighted Soils (Natural) Imperviousness 
 and Weighted Land use Imperviousness for each subbasin. 

3.2.2 Determining Controlling Initial Soils Moisture Content for each Subbasin 

Initial soil moisture or Initial Content (WPOINT, FCAPAC or SAT) within each subbasin is assigned based upon 
the soil parameters and land use. For example, for natural or non-irrigated landscapes, a dry condition, as 
represented by the Wilting Point (WPOINT), is utilized.  For irrigated landscapes such as lawns, a normal 
condition saturated content, specified as the Field Capacity (FCAPAC) is assumed and for agricultural land 
uses, saturated initial conditions or Saturation (SAT) is assumed. 

Average initial soil moisture values for use within HEC-HMS were calculated based upon the percent of each 
subarea represented by each moisture condition (dry, normal or saturated) and are calculated via simple 
area weighted average based upon the soil and land use composite data. Land use initial moisture 
assumptions for the example hydrologic model subbasins are shown in Table 2. 

3.2.3 Determining Initial Content, Saturated Content, Suction and Conductivity for each Subbasin 

Calculations for Initial Content (WPOINT, FCAPAC or SAT) can be accomplished by first determining the 
controlling initial conditions of either Wilting Point (WPOINT), Field Capacity (FCAPAC) and Saturation (SAT) 
values for each soil map unit based on land use representing dry, normal, and saturated conditions. For 
subbasin 035, these values are shown in Table 4 below. 
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Note:  Land use code per Table 2. 

Depending upon the detail and accuracy of available soil and land use spatial datasets, an intersection of the 
land use initial moisture conditions with the soil moisture parameters can be used to subdivide the soil initial 
moisture capacity based upon different land use types (as described above and shown in Table 4), but for 
many studies, use of a single initial moisture condition per subbasin is acceptable. If the soil and land use 
spatial datasets are intersected, a simple area weighted average of the initial moisture conditions should be 
utilized to calculate the subbasin average value. Similarly, a simple area weighted average should be used 
based upon the selected initial moisture condition for the soils data if a land use/soils intersection is not 
performed. 

For Subbasin 035, the land use for the subbasin varies and the initial content value will be calculated using a 
simple area weighted average assuming a “dry” or “normal” initial soils condition. 

 

4.04∗0.066+0.07∗0.066+1.12∗0.132……….+13.73∗0.093
𝐼𝑛𝑖𝑡𝑖𝑎𝑙 𝐶𝑜𝑛𝑡𝑒𝑛𝑡 = = 0.116 in. 

4.04+0.07+1.12………+13.73

 

Similar calculations using a simple area weighted average for Saturation (SAT) are needed to aggregate the 
data for HEC-HMS. 

Calculation of the Conductivity (XKSAT) value for Subbasin 035 is then accomplished by taking the logarithmic 
area weighted average of the Conductivity (XKSAT) values for the applicable soils from Table 1. 

Table 4  Subbasin 035 Initial Content Values 
Subbasin Soil Soil WPOINT FCAPAC SAT 1Land Initial Initial Subbasin 

Survey 

ID 

Map 

Unit 

[IN] [IN] [IN] Use 

Code] 

Moisture 

Conditions 

Content Area 

[AC] 

35 NV628 482 0.066 0.132 0.441 GR dry 0.066 4.40 

35 NV628 482 0.066 0.132 0.441 LDS dry 0.066 0.07 

35 NV628 482 0.066 0.132 0.441 MDS normal 0.132 1.12 

35 NV628 482 0.066 0.132 0.441 OS dry 0.066 9.65 

35 NV628 482 0.066 0.132 0.441 MDR normal 0.132 1.50 

35 NV628 1520 0.117 0.235 0.437 OS dry 0.117 1.78 

35 NV628 1520 0.117 0.235 0.437 GR dry 0.117 0.27 

35 NV628 1520 0.117 0.235 0.437 GR dry 0.117 31.63 

35 NV628 1520 0.117 0.235 0.437 GR dry 0.117 105.51 

35 NV628 1520 0.117 0.235 0.437 OS dry 0.117 137.82 

35 NV628 1520 0.117 0.235 0.437 MDR normal 0.235 8.73 

35 NV628 251 0.093 0.182 0.431 OS dry 0.093 0.40 

35 NV628 251 0.093 0.182 0.431 GR dry 0.093 9.80 

35 NV628 251 0.093 0.182 0.431 LDS dry 0.093 3.77 

35 NV628 251 0.093 0.182 0.431 MDS normal 0.235 0.77 

35 NV628 251 0.093 0.182 0.431 LDS dry 0.093 0.09 

35 NV628 251 0.093 0.182 0.431 OS dry 0.093 13.73 
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4.04∗log10(1.0806)+0.07∗log10(1.0806)+1.12∗log10(1.0806)………+13.73∗log10(0.5021)
( )

Conductivity (XKSAT) =  10 4.04+0.07+1.12………+13.73  

 

Conductivity (XKSAT) = 10−0.5314 = 0.2942 in/hr 

 

Similar calculations using logarithmic area weighted average for Suction (PSIF) are needed to aggregate the 
data for HEC-HMS. Green and Ampt soil-based parameters are summarized (for the top 3” soil horizon 
dataset) in Table 5. For this example, Excel was used to aggregate the Green and Ampt parameters for each 
subbasin. See Bailey_3in_Green&Ampt.xlsx in 07_DataFiles folder. Once hydrologic parameters are 
calculated for each subbasin, they can be added to the HEC-HMS model. 

Table 5  Green and Ampt Soil Parameter per Subbasins 

Subbasin 

Initial Content  

WPOINT or FCAPAC 

[IN] 

Saturation 

SAT 

[IN] 

Suction 

PSIF 

[IN] 

Conductivity 

XKSAT 

[IN/HR] 

Effective 

Imperviousness 

[% 0-100] 

005 0.121 0.434 7.628 0.2516 0.0 

010 0.114 0.438 7.022 0.2763 0.0 

015 0.115 0.437 7.172 0.2717 0.0 

020 0.117 0.437 7.644 0.2578 0.0 

025 0.114 0.438 7.107 0.2760 1.4 

030 0.116 0.437 7.622 0.2625 4.3 

035 0.116 0.437 5.598 0.2942 6.0 

040 0.130 0.437 5.314 0.2941 12.1 

045 0.127 0.437 5.832 0.2875 10.7 

050 0.130 0.426 0.841 0.7199 22.6 

055 0.175 0.430 2.962 0.3703 24.3 

4. Datasets for Rainfall 

The NOAA’s National Weather Service (NWS) provides the GIS datasets of NOAA Atlas 14 rainfall. The data is 
available from the NWS Hydrometeorological Design Studies Center website: 
https://hdsc.nws.noaa.gov/hdsc/pfds/pfds_map_cont.html?bkmrk=nv. 

5. Developing a HEC-HMS Model 

This example will guide you through various steps to prepare a simple HEC-HMS hydrologic model using the 
NDOT Green and Ampt soils data. Modeling sequence is setup to input all the relevant data for the sub-basins 
and routing reaches then develop the model hydrologic order. Alternatively, the user may find it more 
desirable to prepare the model hydrologic order for each basin and concentration point as they enter the 
data.  This is certainly an option, HEC-HMS Version 4.6 includes data summary tables that can be accessed 
by selecting Parameters in the Menu Bar and navigating to desired menu. Additional discussion and shortcuts 
are included in this example.  
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5.1 Getting Started 

Start HEC-HMS by clicking on the HEC-HMS icon by going to Start → Programs → HEC-HMS → HEC-HMS 4.6. 

After a few seconds, the following should appear: 

 

Desktop 

Watershed 
Explorer 

Component 
Editor 

Message Log 

Menu Bar 

Tool Bar 

This window represents the HEC-HMS Interface. The HEC-HMS interface consists of a menu bar, tool bar, and 
four panes. These panes are referred to as the Watershed Explorer, the Component Editor, the Message Log 
and the Desktop. These panes are further discussed later in the example. 

5.2 Creating a Project 

1. Open a new project in HEC-HMS (File → New). 

2. Enter the following in the “Create a New 

Project” dialog box: 

a. Name: Bailey Canyon Creek 

b. Description: HEC-HMS Example 
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c. Location: Point the browser to the location you would like the project stored.  Remember this 

location because you will need to retrieve the project later. 

d. Default Unit System: Select “US Customary” or prepare to 

do lots of metric conversions. 

e. Click on “Create”. Note that a file folder called “Bailey 

Canyon Creek” appears in Watershed Explorer. 

3. Set the program default settings (Tools → Program Settings → 

Defaults) to what you think they ought to be (we can update this 

later, but setting the defaults is a good habit). 

5.3 Creating a Basin Model 

1. Create a Basin Model (Components → Basin Model Manager). In 

the “Basin Model Manager” dialog box, create the Bailey Canyon 

Creek model by doing the following: 

a. Click “New” 

b. Enter “Bailey” for Name and a 

description of your choice. 

c. Click “Create.” Note that a file folder 

called “Basin Models” appears in the 

Watershed Explorer. 

d. Close the Basin Model Manager dialog 

box and expand the “Basin Models” file 

folder to reveal a subfolder called 

“Bailey”. 

e. Click on the Bailey folder – the basin model screen in the Desktop becomes active. 
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2. Setting coordinate system - Clicking GIS → Coordinate System.  Select either Predefined or Browse.  

For this example, a coordinate system is provided.  Select Browse and navigate to the folder 

(03_Projections) location containing the projection file “NAD 1983 StatePlane Nevada West FIPS 2703 

(US Feet).prj” then click set. This will set the coordinate system when importing georeferenced GIS 

files. Note: Don’t worry if this step is skipped, the model will use 

the coordinate system of the first imported GIS file from Step 3 

below. 

3. Importing GIS basin and routing reach shapefiles by clicking GIS 

→ Import Georeferenced Elements. For this example, select 

“Next” to go to step 2 of the import process. Navigate to the file location (04_GIS), select 

“Bailey_Basins.shp”. Select “Next” to go to step 3 of the import process. 

Available shapefile column headers will appear for the subbasin names. For 

this example, select “name” and then “Finished”. Repeat process for routing 

reached. Each subbasin and routing reach imported will appear under “Basin 

Model” but will not include modeling data other than georgaphic 

location (Latitide and Longitude) and basin area. Using the same 

process, add Bailey_Junctions.shp.  this file will be usefull in developing 

the hydrologic model in Section 5.8. 

4. Note: In lieu of using subbasin shapefiles described in Step 3 above, each 

subbasin can be entered manually using the Tool Bar. 

a. To enter and label subbasins click on the subbasin icon         

b. Enter a description for each subbasin or leave it blank. 

c. Repeat for each subbasin in the watershed. 
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d. This example will continue from Step 3. 

5.4 Creating a Meteorologic Model 

Create a Meteorologic Model (Components → Meteorologic Model Manager). In the “Meteorologic Model 
Manager” dialog box, create the model by doing the 
following: 

1. Click “New” 

2. Enter “Rainfall” for Name and a description of your 

choice. 

3. Click “Create.” Note that a file folder called 

“Meteorologic Models” appears in the Watershed 

Explorer. 

4. Close the “Meteorologic Model Manager” dialog 

box and expand the “Meteorologic Models” file 

folder to reveal a subfolder called “Rainfall.” 
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5. Click on the “Rainfall” folder – the Meteorology Model 

appears in the Component Editor. 

6. Make sure the Precipitation is set to “Frequency Storm”. If 

you set up your project defaults the values should already be 

set. If not, set the values as shown in the image to the right. 

7. Go to the “Basins” tab and set the Basin model to include 

subbasins by selecting “Yes” from the drop-down menu. 

8. Click on the “Frequency Storm” folder below the Rainfall folder 

on the Watershed Explorer. The precipitation table will appear 

in the Component Editor. 

9. Select “None” for Annual-Partial Conversion, “1 Day” Storm Duration, 

“5 Minutes” Intensity Duration, “50 Percent” Intensity Position, 

“None” for Area Reduction and “Uniform for All Subbasins” for 

Curve. 

10. Type in the values for the rainfall durations from 5 minutes to 1 day 

from the original hydrologic study. 

Note: Rainfall depths entered were reduced to 98% of the point 

rainfall valued to mimic the use of the JR record in the HEC-1 from 

the Original Hydrologic Study. 

11. For other studies, rainfall values for a watershed can be obtained 

online from the NOAA Precipitation Frequency Data Server (PFDS) 

noted in Section 4. Navigate to PFDS website then under 1) Manually, 

a) By Location, the user can manually enter the latitude and 

longitude for the watershed. Entering the watershed 

latitude/longitude will generate a Point Precipitation Frequency (PF) 

estimates which can be downloaded as an I-D-F (Intensity Duration 

Frequency) or a D-D-F (Depth Duration Frequency) comma separated 

value file (.csv). Appropriate values can then be entered in the 
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Frequency Storm tab for the desired storm event. See output example in folder 06_Precipitation. 

5.5 Entering Rainfall Losses 

1. Expand the “Basin Models” folder so that each of 

the 11 subbasins are shown. 

2. Highlight subbasin 055 and note that the 

Component Editor changes to show four tabs 

(Subbasin – Loss – Transform – Options). 

3. On the “Subbasin” Tab: 

a. For this example, the drainage area field 

was populated from the Basin shapefile 

imported earlier as well as the 

Latitude/Longitude of the centroid of each 

basin. 

b. Make sure the Canopy Method is set to 

“None.” 

c. Make sure the Surface Method drop down box is set to “None”. 

Note: if you select “Simple Surface” a fifth tab, “Surface” will 

appear in the Component Editor. 

d. Make sure “Green and Ampt” is selected in the “Loss Method” 

drop down box. 

e. Note: At this time “Downstream” (used for model hydrologic 

order) is not populated. For ease of developing a model from 

scratch, modeling hydrologic order will be developed after basin 

and routing data is populated for each element. 
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4. On the “Loss” Tab 

a. “Initial Content”: Use Initial Content value from Table 5. 

b. “Saturated Content”: Use the Saturation (Sat) value from 

Table 5. 

c. “Suction”: Use the Suction (PSIF) value from Table 5. 

d. “Conductivity”: Use the Conductivity (XKSAT) value from 

Table 5.  

e. “Impervious”:  Use the Effective Imperviousness value 

from Table 5. 

5. Do not enter any information on the “Transform” or “Options” 

Tabs for now. 

6. Repeat process for all subbasins. 

Note: Navigating to Parameters → Loss → Green and Ampt produces 

a summary table to enter all subbasin Green and Ampt parameters.  Enter Green and Ampt Loss 

parameters from Table 5. 

5.6 Developing Unit Hydrograph Data 

SCS Unit Hydrograph.  The SCS Unit Hydrograph method was used in the example project provided by NDOT 
staff and will be used in this example. 

1. The time of concentration (Tc) equation was selected from the Truckee Meadows Regional Drainage 

Manual (2009). 

𝐿 𝐿 0.33
𝑐

𝑇𝑙𝑎𝑔 = 22.1𝐾𝑛 ( )  EQUATION 710 (TRUCKEE MEADOWS 
𝑆0.5

REGIONAL DRAINAGE MANUAL (2009))  

where; 

Tlag = Lag Time (hrs) 

Kn  = Manning's Roughness Factor for the Basin Channels 

L  = Length of the watercourse to the hydraulically most distant point (mi) 

Lc = Length Along Longest Watercourse Measured Upstream to a Point Opposite the 
Centroid of the sub-basin (mi) 

S  = Representative (Average) slope of the Longest Watercourse (ft/mi) 
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Table 6  Subbasin Lag 

HEC-HMS ID Kn L 

[mi] 

Lc 

[mi] 

S 

[ft/mi] 

Tlag 

[MIN] 

005 0.12 2.64 1.22 329 90 

010 0.12 2.78 1.42 617 87 

015 0.12 2.64 0.98 693 74.4 

020 0.12 2.36 0.89 360 76.8 

025 0.12 2.99 1.66 615 93.6 

030 0.10 2.29 1.03 603 61.2 

035 0.08 1.41 0.5 395 35.4 

040 0.07 2.36 1.09 620 43.8 

045 0.07 2.71 1.44 510 52.2 

050 0.05 1.25 0.74 81 31.2 

055 0.05 1.89 1.02 133 36.6 

 

5.7 Entering Unit Hydrograph Parameters into HEC-HMS 

Now that you have estimated unit hydrograph parameter, enter the 
information in the HEC-HMS model. 

1. Expand the “Basin Models” folder so that each of the 11 subbasins are 

shown. 

2. Highlight subbasin 055 and note that the Component Editor changes to 

show four tabs (Subbasin – Loss – Transform – Options). 

3. On the “Transform” Tab: 

a. Enter the Tlag from Table 6 for subbasin 055 in “LagTime (MIN)”. 

b. To aid in entering data for multiple subbasins, go to the 

Parameters → Transform → SCS Unit Hydrograph. The SCS 

Transform window will open. 

c. Change the selection on “Show Elements” to “All 

Elements”. You can now enter the SCS Unit Hydrograph 

parameter for the rest of the subbasins here.  When 

finished, click “Apply” 

You have now completed the data entry for the subbasins.  For this 
example, we won’t be using the “Options” tab. 

Note: Roughness factor Kn interpolated from Table 703 in City of Sparks Hydrologic Criteria and Drainage Design Manual. 
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5.8  Creating Model Junctions 

1. Expand the “Basin Models” folder so that each of the 11 sub-basins 

are shown. 

2. Select the Junction Tool from the Tool bar.           Drag the Junction 

Tool to the Junction Point at the outlet of subbasin 010/015 and 

click to add. (Note: Make sure background map for Junctions is 

active.  To check this, go to View → Map Layers and verify that the 

box is checked for Junctions shapefile imported earlier). 

3. Type in Name (CP010) and Description then click enter.  Repeat 

until all Junctions in Table 7 are added to the model. 

Table 7  Junctions 
Junction Name Basin 

Outlet/Combination 

Point 

CP010 005/010 

CP015 015 

CP025 020/025 

CP030 030 

CP035 035 

CP040 040 

CP045 045 

CP050 050 

CP055 055 

CP055B 050/055 

5.9 Creating Routing Reaches 

Routing reaches elements were created in Section 5.3 when importing shapefile using the GIS → Importing 
Georeferenced Elements. 

Alternatively, the routing reaches could be entered into the model using the following process. 

1. Select Reach Creation Tool          on the Menu Bar. 

Click first at CP010 (outlet to subbasin 005 and 

010) and then again at CP015.  A pop-up window 

will appear.  Type in the Reach “Name” from Table 8 and Reach “Description” if desired. When 

finished, click “Create”.  The routing reach will be created.  Continue for all routing reaches listed in 

Table 8. 

 

Table 8  Routing Reaches  

Routing Reach Upstream 

Connection 

Downstream 

Connection 

R015 CP010 CP015 

R025 CP015 CP025 

R030 CP025 CP030 

R035 CP030 CP035 

R040 CP035 CP040 

R045 CP040 CP045 

R050 CP045 CP050 

D055 D040 (Section 5.12) CP055 
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5.10 Linking model elements 

1. Link Junctions/Diversions to Downstream model elements 

a. Highlight/double click “CP010”. A Component Editor 

box will appear. Data can be entered in this menu or 

in the standard Component Editor menu.  For the 

“Downstream” link, select “R015” from the 

dropdown menu. 

b. No data will be entered on the “Options” tab. 

c. Continue for all junctions listed in Table 9. 

d. Diversion D040. More about Diversions in Section 

5.12. 

e. Note: Once you select the 

“Downstream” link, the routing 

reach will move in the list directly 

below the Junction when another 

element is selected. You can right 

mouse click on “Bailey” and select to lock current element order by selecting “Lock Element 

Locations” or “Lock Hydrologic Order” if you prefer the model hydrologic order. For this 

example nothing is selected until all elements have been linked then “Lock Hydrologic Order” 

will be selected. 

2. Link Subbasins to Downstream model elements. 

a. Simular to Junctions, highlight subbasins either by 

double clicking on the element in the Desktop or 

through the Watershed Explorer. 

b. Continue for all subbasins listed in Table 10. 

c. Note: As you complete the link you will notice a 

connection line apear in the Basin model between 

the subbasin and the downstream element. 

 

Table 9  Linking Junctions 

Junction Basin 

Name Outlet/Combination 

Point 

CP010 R015 

CP015 R025 

CP025 R030 

CP030 R035 

CP035 See Section 5.12  

CP040 R045 

CP045 R050 

CP050/CP055 CP055B 

Table 10  Linking Subbasins 

Sub-basin Downstream 

Connection 

005/010 CP010 

015 CP015 

020/025 CP025 

030 CP030 

035 CP035 

040 CP040 

045 CP045 

050 CP050 

055 CP055 

050/055 CP055B 
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5.11 Adding data to each reach in the basin model 

1. Inputting Routing Data 

a. With model links completed for each subbasin, diversion and junction, next step is to add the 

links for the routing reaches and inputting the routing data. 

b. To begin, highlight Routing Reach R015 either by 

double clicking on the element in the Desktop or 

through the Watershed Explorer. 

c. Select “Downstream” element per Table 8. 

d. For all Routes, the “Routing Method” will be 

“Muskingum-Cunge”. 

e. “Loss/Gain Method” will remain “--None--”. 

f. Add routing data from Table 11 for each routing reach. 

g. “Time Step Method” will be set to “Automatic Fixed Interval” for all 

reaches. 

h. “Invert (ft)” to be left blank. 

i. After all data in entered, Save Model 

j. Data can be entered in each individual routing reach or by using a 

summary table through Parameters → Routing → Muskingun-Cunge. 

Table 11  Reach Routing Parameters (Muskingum-Cunge) 

HEC-

HMS ID 
Length 

(ft.) 

Energy 

Slope  

(ft./ft.) 

Manning’s N 

Values 

Index 

Flow 

Shape Bottom 

Width 

(FT) 

Side 

Slope 

(xH:1V 

R015 3529 0.045 0.073 347 Trapezoid 100 2 

R025 9817 0.045 0.078 676 Trapezoid 50 2 

R030 4069 0.039 0.1 1188 Trapezoid 25 3 

R035 3714 0.034 0.108 1374 Trapezoid 70 4 

R040 3539 0.029 0.073 1144 Trapezoid 30 50 

R045 1734 0.023 0.086 1182 Trapezoid 30 50 

R050 5748 0.018 0.053 1234 Trapezoid 20 2 

D055 9490 0.026 0.045 246 Trapezoid 8 10 
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k. Note: For this example, “Initial Type” is set to “Discharge=Inflow”, “Space-Time Method” is set 

to “Auto DX Auto DT”, and “Index Method” is set to “Flow”. 

l. Index Flow = (Peak Incoming Flow + Baseflow)/2.  Where the peak incoming flow (for the 

connected subbasins to be modeled) is determined by preprocessing each subbasin watershed 

separately as a non-connected independent subbasin and then recording the peak flow outputs 

of each non-connected watershed.  These non-connected output results will then be used as 

the peak incoming flows for the connected sub-watersheds model. 

m. Options tab to remain unchanged. 

5.12 Adding a Diversion 

As part of the original hydrologic study, a diversion was added at Junction CP035 that diverts a portion of the 
flow through a culvert structure and along the road embankment.  Flow eventually recombines at the model 
outlet (CP055B). To add a Diversion, 

1. Select View → Zoom In to navigate to CP035. 

2. Select the Diversion Tool from the Menu bar.           Drag the Diversion Tool to the Junction Point 

CP035 at the outlet of subbasin 035 and click to add. 

3. Type in “Name” (D040) and “Description” then click enter.  At this point the Diversion is entered but 

is not associated with any data. 

4. Entering Paired Data - For this example, the diversion is represented by an rating curve that is 

entered in HEC-HMS as paired data. 

a. Select Components → Paired Data Manager and for “Data 

Type “select “Inflow-Diversion Functions” from the pull-

down menu then select New. Enter name and Description as 

shown then select Create and close Time-Series Data 

Manager by selecting X in the upper right corner. 
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b. In the Watershed Explorer, navigate to the Paired 

Data – Inflow-Diversion Function – DV035 created 

above. Under the “Table” tab enter in the values 

from Table 12. 

Table 12  Diversion Rating Table 

Inflow (cfs) Diversion (CFS) 

0.0 0 

510.0 0 

913.0 23 

1580.0 144 

2460.0 380 

3514.0 749 

1000000.0 1000 

Note: Diversion rating table values reported from the Original Hydrologic Study. 

5. Linking Diversion 

a. Under “Basin Model”, highlight “CP035” and add “D040” 

from the pull down menu, as the downstream 

connection. 

 

 

 

 

 

b. Next, highlight “D040” and add “R040“ as “Downstream” 

link and “D055” as “Connection”. Select “Inflow 

Function” from the pull down menu as the “Divert 

Method”.  
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When complete your basin model should look similar to this → 
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5.13 Define Control Specifications 

Now, set up the control specifications for the first run. 

1. Open the Control Specifications Manager (Components → 

Control Specifications Manager) and select “New”. 

2. Keep the Default name suggested by HMS or create your own 

name. It is not necessary to create a description. Click “Create”. 

Note: New Control Specifications folder appears in the 

Watershed Explorer. 

3. Expand the “Control Specifications” file folder to reveal a 

subfolder called “Control 1”. 

4. Click on the “Control 1” folder – the Control Specifications 

appears in the Component Editor. 

5. Enter “01Jan2000” for the “Start Date” and “03Jan2000” for 

the “End Date”. This is from the Original Hydrologic Study 

model. Enter “Start Time” and “End Time” of “00:00”. 

6. Set the “Time Interval” to “5 Minutes”. General guidance for selecting a time interval is given in the 

HEC-HMS Applications Guide online. 

7. Save your file. 

5.14 Run Model 

Let’s get some answers by running the model. 

1. Set up the Run for the first time by selecting 

Compute → Simulation Run Manager → 

New at the top of the HEC-HMS menu bar. 

Use the default name as “Run 1” or type 

“100yr,24hr” for the Name in the first screen of 

the “Create a Simulation Run [Step 1 of 4]” box that pops 

up.  Then click “Next.”  Select the “Bailey” basin model (it should 

be the only one available) and click “Next.” Select the “Rainfall” 
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meteorologic model (again, the only choice) and click “Next.” Finally select the “Control 1” 

specifications and click “Finish.” Close the Simulation Run Manager dialog box. 

2. Along the menu bar, in the pull down window, select the “Run” just setup. For this example, select 

“Run 1”. 

3. Note that the “RUN” icon         is no longer grayed out on the tool bar.  Click the        to run your 

model.  A progress bar will appear to show the computational progress, or a series of red error 

messages will appear in the Message Component and the dialog box will be titled “Failed Computing 

[filename].” To debug your model: 

a. Read the error messages and take action. 

b. Consult the User’s Manual for additional guidance. 

4. If all goes well, the dialog box will read “Finished Computing “Run 1” and the progress bar will go to 

100%.  Close the progress dialog box. 

Read the Notes and Warnings in the Messages Component of the view screen and respond to any notes or 

warnings that require action. 

5.15 View & Review the Results 

Global summary results can be viewed by clicking on the Global Summary         icon. There are several other 
ways to view the model results.  Hover your mouse over one of the basin elements in the Desktop Component 
area and right click the mouse. Click “View Results” and look 
at the graphical, summary table, and time-series table. Next, 
click on the Results Tab in the Watershed Explorer. Click on 
the one of the model elements and scroll the various types 
of output. Finally, try plotting two graphs on a single figure 
by holding the control key and selecting two (or more) 
elements (suggest looking at an inflow and routed 
hydrograph). Note which results plot in the Desktop and 
which plot in the Components Editor. 
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Custom reports in HTML format can also be created by going to Tools → Reports → Standard Report. 

 

 

Other model runs were included in the Example HEC-HMS model. 

 Run:  Run 2 – Basin Model: Bailey and Meteorologic Model: DARF (See Section 6.2) 

Run:  Run 3 - Basin Model: Bailey -IA (See Section 6.1) and Meteorologic Model: DARF (See Section 
6.2) 

 Run:  Run 4 - Basin Model: Bailey -IA (See Section 6.1) and Meteorologic Model: Rainfall. 

6. Additional Modeling Considerations 

Green and Ampt infiltration, in the absence of other considerations, models a soil percolation process and 
does not account for other relevant rainfall loss aspects such as initial abstraction, precipitation point-rainfall 
reduction, canopy loss, vegetative impacts on conductivity, and surface imperviousness. In the example 
above, land use based imperviousness is discussed and applied, but these other aspects are not addressed in 
detail in this document. 

6.1 Initial Abstraction using Canopy or Surface Methods 

6.1.1 Canopy Method 

Vegetative cover effects on rainfall losses may be expressed in multiple ways. Canopy loss may be utilized to 
represent initial abstraction effects on rainfall applied to the soil prior to infiltration calculations. In special 
circumstances where interception losses are believed to be significant and separable from surface depression 
losses, the “Canopy Method” may also be applied. These circumstances might include heavily forested areas 
where significant tree canopy captures additional rainfall preventing it from reaching the ground. Select 
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guidance for arid vegetative cover adjustments may be found in the ADOT Hydrology Manual (Arizona 
Department of Transportation, 2014) and Mohave County (Arizona) Drainage Design Manual (latest edition). 

6.1.2 Surface Method 

Consideration has not been included in the Green and Ampt analyses in this document to account for initial 
abstraction in the form of surface storage loss. Surface storage loss is typically implemented within HEC-HMS 
using the “Surface” component of a subbasin and allows an initial and maximum surface storage depth to be 
included in the analysis. Additional information and guidance regarding “surface storage” and selection of 
appropriate initial abstraction values may be found in the ADOT Hydrology manual (Arizona Department of 
Transportation, 2014) and Mohave County (Arizona) Drainage Design Manual (latest edition). 

6.2 Depth Area Rainfall Reduction 

Rainfall depths entered were reduced to 98% of the point rainfall valued to mimic the use of the JR record in 
the original HEC-1 Bailey Canyon hydrologic model. Depth Area Reduction Factors (DARFs) were developed 
by NDOT for use in areas outside of Clark County.  Updated equations are included below. 

 

For an additional exercise, replace the point rainfall valued in Step 10, under Section 5.4 with DARF values in 
Table 13 rerun and compare the results with the current model. 

Table 13  Point Rainfall Values for 100-year recurrence interval 

Duration 

Min or Hr 

100-year  

(No Reduction) 

[in] 

Reduced to 98% per Bailey 

Canyon hydrologic model 

[in] 

Reduced to 88% per NDOT 

DARF24hr Equation 

[in] 

5-min 0.43 0.42 0.38 

15-min 0.81 0.80 0.71 

60-min 1.35 1.32 1.19 

2-hr 1.45 1.42 1.28 

3-hr 1.56 1.53 1.37 

6-hr 2.03 1.99 1.79 

12-hr 2.95 2.89 2.60 

24-hr 4.02 3.94 3.54 
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Appendix A.  Glossary 
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attenuate - To reduce the flood peak discharge and lengthen the time base of the flood wave. 

base flow - Discharge in a river prior to the onset of direct runoff from a rainfall event. 

concentration point - A physical location in a watershed where all surface runoff must pass to exit the 
watershed. 

direct runoff - The same as rainfall excess. 

distribution - Function describing the frequency with which random events of various magnitudes occur. 

drainage area - The total area contributing to surface runoff at a point of interest (flow concentration point). 

duration - Used either as the length of time for rainfall, such as a 24-hour storm, or as the length of time for 
rainfall excess, such as used to specify the duration of rainfall excess for a unit hydrograph. 

effective impervious area - The portion of a land area, expressed in percent of total land area, which will 
drain directly to the outlet of the drainage area without flowing over pervious area. This is often called 
directly connected impervious area. 

exceedance probability - Probability that a flood discharge will exceed a specified magnitude in a given time 
period, usually one year unless otherwise indicated. 

field capacity - Amount of soil moisture or water content held in soil after excess water has drained away 
and the rate of downward movement has materially decreased, which usually takes place within 2–3 
days after a rain or irrigation in pervious soils of uniform structure and texture. 

frequency - The measure of the probability of occurrence or exceedance of a flood magnitude in a number 
of observations. 

hydraulic conductivity – A description of the ease with which a water can move through pore spaces or 
fractures. 

hydrograph - A continuous plot of instantaneous discharge versus time. 

hydrologic soil group - A classification system developed by the NRCS to place soils into one of four groups 
based on runoff potential. 

impervious area - The portion of a land area, expressed in percent of total land area, which has a negligible 
infiltration rate. Impervious area can be natural, such as rock outcrop (soils (natural) impervious area) 
and the surface of permanent water bodies; or man-made, such as paved areas, roofs, and so forth 
(land use impervious area). 

infiltration - The rate of movement, in inches per hour, of rainfall from the land surface into and through the 
surface soil. 
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initial abstraction - The accumulative loss, due to all mechanisms, of all rainfall from the start of rainfall to 
the point in time when surface runoff begins. This is equivalent to the initial loss in the “Initial and 
Constant Loss” method. 

percolation - The rate of movement, in inches per hour, of water through the underlying soil or geologic 
strata subsequent to infiltration. 

physiography - The physical geography of a watershed. 

population - The entire (usually infinite) number of data from which a sample is taken or collected. The total 
number of past, present, and future floods at a location on a river is the population of floods for that 
location even if the floods are not measured or recorded. The frequency distribution of the population 
defines the underlying probability model from which the sample of annual floods arises. 

rainfall excess - The equivalent uniform depth of runoff, in inches, that drains from the land surface. Rainfall 
excess equals rainfall minus rainfall losses. 

rainfall losses - The sum of rainfall that is lost to surface runoff due to interception, depression storage, 
evaporation, infiltration, and other mechanisms. Rainfall loss is expressed as an equivalent uniform 
depth, in inches. 

reach - A relatively short length of channel or watercourse. 

return period - The average number of years between occurrences of a hydrological event of a given or 
greater magnitude. In an annual flood series, the average number of years in which a flood of a given 
size is exceeded as an annual maximum. 

routing - A procedure by which an inflow hydrograph is modified by the effects of flow resistance and storage 
to simulate an outflow hydrograph from the system. 

soil - The layer of inorganic particulate matter covering the Earth's surface. It can and does contain organic 
matter and often supports vegetation. For the purpose of estimating rainfall losses, only the upper 
horizon (generally about the top 3 inches of soil) will be considered. Underlying soil horizons or other 
strata will generally not affect rainfall losses in Nevada for storms of 100-year magnitude or less. 

soil texture - The classification of soil into groups according to percentage of sand, silt, and clay, as used by 
the U.S. Department of Agriculture. 

sand - Soil composed of particles in the 0.05 mm to 2.0 mm size range. 

silt - Soil composed of particles in the 0.002 mm to 0.05 mm size range. 

clay - Soil composed of particles smaller than 0.002 mm. 

soil map unit – A collection of areas defined and named the same in terms of their components (e.g., series) 
or miscellaneous areas or both. The basic unit of a soil map. 
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subarea - A portion of a drainage area or subbasin that is delineated according to a physical feature such as 
soil texture or land use. 

subbasin - A portion of a drainage area or watershed that is determined according to the internal surface 
drainage pattern. A drainage area can often be divided into subbasins for modeling purposes. 

surface retention loss - The depth of rainfall loss, in inches, due to all factors other than infiltration. 

time of concentration - The travel time, during the corresponding period of most intense rainfall excess, for 
a flood wave to travel from the hydraulically most distant point in the watershed to the point of 
interest (concentration point). 

topography - The surface features of a watershed. 

unit hydrograph - The hydrograph of one inch of direct runoff from a storm of a specified duration for a 
particular watershed. 

vegetation cover - The percentage of land surface that is covered by vegetation. Vegetation cover is 
evaluated on plant basal area for grasses and forbs, and on canopy cover for trees and shrubs. 

watershed - The area within definable boundaries in which all direct runoff drains to a common outlet. 

wetting front suction – Portion of the total head driving infiltration at the wetting front (interface between 

saturated soil above and drier soil beneath). 

wilting point - The point at which, through heat or drought, a plant loses turgidity and becomes limp and 
flaccid. 
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Appendix B. HEC-HMS Model Support Data 
Supporting Data Folders and Files Include: 

01_BailyCanyonCreekStudy 

• Includes referenced document - Washoe County Regional Transportation Commission, Geiger Grade 
Road Realignment Project, Kimley Horn and Associates, Inc. (2011). 

 
02_SoilsData 

• Includes Green and Ampt soils data shapefiles used in model example. 
o NV628 
o NV772 

 
03_Projections 

• Includes ArcView projection file for GIS data.  
o NAD 1983 StatePlane Nevada West FIPS 2703 (US Feet).prj 

 
04_GIS 

• Includes GIS files used in the model example. 
o Bailey_Basins.shp  
o Bailey_Junctions.shp 
o Bailey_Routes.prj 
o Bailey_Landuse.shp 
o Bailey_Soils_Merged.shp 
o Bailey_Basins_Soils_Intersect.shp 
o Bailey_Basins_Soils_Landuse_Intersect.shp 

 
05_MXD 

o Example_Bailey.mxd 
 
06_Precipitation 

• Includes NOAA precipitation files used in model example. 
o PF_Depth_English_PDS.csv 
o Precipitation Frequency Data Server.pdf 

 
07_DataFiles 

• Datafiles used to process lumped basin parameters 
o Bailey_3in_Green&Ampt.xlsx – Spreadsheet used to determine Green and Ampt parameters 

with adjustments for subbasin average Initial Content and land use imperviousness. 



Soil data files available upon request 
 

Contact NDOT Research at (775) 888-7000   
info@dot.nv.gov  and request 

 
 

“Research Project 674-19-803 Soil Data” 

mailto:info@dot.nv.gov


 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Nevada Department of Transportation 
Kristina L. Swallow, P.E. Director 

Ken Chambers, Research Division Chief 
(775) 888-7220 

kchambers@dot.nv.gov 
1263 South Stewart Street 

Carson City, Nevada 89712 
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